CSAT 3350: ADVANCED 2D IMAGING
FA 3302: ADVANCED DIGITAL IMAGING

2-3.15pm, Tuesday and Thursday | January – May, 2015 | Room BAB 302, SRSU
Avram Dumitrescu
adumitrescu@sulross.edu 432-837-8380
Office: FAB 07
Office Hours: MWF: 11am-12.30pm
TR: 3.15-4.15pm
and by appointment

Course Introduction
In this class you will explore the more advanced features of Adobe Photoshop and Adobe Illustrator to create and
manipulate digital images. You will also learn the basics of digital painting using Corel Painter X3. Note that
this course is a continuation of CSAT 2310: Intro to Digital Imaging, and CSAT 2302: Intro to Digital
Design.
Learning Objectives
In this course, you will:
■ Explore more deeply Adobe Illustrator and Photoshop to create and manipulate digital imagery.
■ Use Corel Painter X3 to begin learning digital painting.
■ Explore 3D imagery using Illustrator and Photoshop.
■ Continue working on graphic design skills through color choices, text placement, and
composition in class exercises and projects.
■ Continue building your visual communication skills as you create high-quality, easy-tounderstand imagery, and your oral communication skills during weekly critiques as you explain
your designs to the class and the professor
■ Use teamwork as a tool to improve each other’s projects through weekly critiques. Teamwork is
also encouraged during class time so that you can comment on and assist with the creative and
technical side of each other’s projects. You will also work in small teams for a number of
projects.
Grading and Evaluation
You will be graded on exercises, attendance and participation in discussions and critiques, homework
projects, and a final project. All assignments will be evaluated for effort, technical ability, concept, execution,
and presentation.
Each project, apart from the exam, will be graded pass/fail. A pass earns you 100% and a fail earns you 0%.
Details on how to pass each project is included in the project’s description. The exam will be graded on a
scale from 0-100%.
Please note that work submitted no later than the beginning of class, the day of the deadline, will be graded.
Any work submitted one minute past the beginning of class will be awarded a zero. There are no
exceptions to this rule.
Your final class grade will consist of:
■ Projects : 70%
■ Attendance, participation, and in-class exercises : 15%
■ Final exam : 15%
Materials and Text
■ 4GB (at least) jump/flash drive
■ Materials to sketch in - paper, pencil, sharpener, eraser, paper/sketchbook
■ Access to a digital camera
■ Notebook and pen

No textbook is required for this course but a jump-drive is essential for saving your work. You are expected
to back up your projects to another location, such as at a free service like www.dropbox.com or
www.google.com/drive. Not submitting a project because you lost your jump-drive or some other technical
difficulty will not be accepted as an excuse and will earn you a zero for that project.
Highly Recommended Texts
The following texts are not required for class but are highly recommended if you choose to digital imaging.



The Adobe Illustrator Wow! Book - Sharon Steuer
ISBN-10: 0133928500
Photoshop Down & Dirty Tricks for Designers, Volume 2 – Corey Barker
ISBN-10: 0133795640

Software Availability
Besides access to the software in classroom, you can find Photoshop and Illustrator in the library on the
second floor, in FAB 207, and the ACR computer labs. Corel Painter is available only in BAB 302 – the
student edition is reasonably priced and can be bought as a digital download from a service such as
www.amazon.com
Provided you have your own computer, a fully-working 30-day trial version of Photoshop and Illustrator can
be downloaded from Adobe.
Rules and expectations
Attendance is compulsory. If you must miss a class for a school-related activity, the absence must be
discussed (and arrangements made regarding coursework) prior to the absence. If you must miss a class for
an emergency or illness, please contact me by email or phone as soon as possible. Six (6) absences result in
you being dropped from the course with a grade of “F” as per Sul Ross State University policy. Five (5)
unexcused absences will result in a zero for your attendance and participation grade. Arriving to class on time
is also essential – arriving late more than two times will be counted as one absence. Lateness is
defined as 15-minutes after the start of class. Leaving before class ends will result in you being
marked absent.
Below is a guide to how much each absence impacts your attendance and participation grade.




One (1) unexcused absence:
Two (2) unexcused absences:
Three (3) unexcused absences:

-20%
-40%
-60%





Four (4) unexcused absences:
Five (5) unexcused absences:
Six (6) unexcused absences:

-80%
- 100%
FAIL

No cell phone usage. No social-networking websites. No instant-messaging. No checking personal emails.
Headphones and earbuds are allowable ONLY when you are working, but not when the professor or a fellow
student is speaking. Class disruption of any kind. Doing any of these will drastically drop your
attendance and participation grade.
Late work will not be accepted.
Plagiarizing, cheating, or any other dishonest behavior in the classroom will not be tolerated. Rules
and regulations regarding plagiarism, dishonesty, and other issues concerning classroom participation can be
found in University Rules and Regulations and Student Handbook. This course will abide by these established
policies. A student found to be engaging in these activities will be penalized to the full extent of Sul Ross
State University policy.
ADA Needs

It is Sul Ross State University policy to provide reasonable accommodations to students with disabilities. If a
student would like to request such accommodations because of a physical, mental, or learning disability,
please contact the ADA Coordinator in the Ferguson Hall, room 112 or call (432) 837-8691. Please relate all
requests for special accommodations to the instructor by the third class period.

Please note that this syllabus is subject to change.
COURSE SCHEDULE
Note – Numbers in parentheses (x) denote the folder images are stored in.
WEEK ONE
Jan 20 (T):

Class introduction and syllabus overview.

Homework – Come to class with three impressive digital images in PowerPoint

format. Email your presentation to the professor before the start of the next class.
Jan 22 (R):

Download the Advanced Digital Imaging files zip file from sulross.blackboard.com and save it to
your personal space. Ensure that you unzip the files before using.
PRESENTATION: Student presentations
Homework – Come to next class with a pencil, sharpener, and drawing
paper/sketchbook.
WEEK TWO

Jan 27 (T):

PRESENTATION: Logos.
– Exercise –
* Use the pen tool to follow the a) straight to straight, b) straight to curve, c) curve to curve,
and d) vehicle. (1)
PROJECT – Personal logo using Live Trace and Live Paint.

Jan 29 (R):

Using Pathfinder. Combining simple shapes to create complex shapes.
PROJECT – Use simple geometric shapes and the pathfinder menu to create ONE of the
following for a children’s book in the style of Charley Harper:
 A dragon and castle in a suitable background
 Three jungle animals in a jungle environment
 An astronaut, his/her spacecraft, and an alien planet background
WEEK THREE

Feb 3 (T):

DUE TODAY: Personal logo due at beginning of class.
– Exercise –
* Remove the backgrounds from all the model images in folder (2). Use the Quick Selection
tool (White Matt), Refine Edge, On Layers. Do the same to the water and fire images. Make
selections with the Channels panel and Matting > Remove Black (or white).
Add fire and water to each model image (fire and water may be reused for each image).

Feb 5 (R):

Camera Raw. Color Balance Reading a histogram. Using Threshold. Finding darks, lights,
and neutrals. Working with Curves. The Unsharp mask. Color correct the images in (3)

WEEK FOUR
Feb 10 (T):

DUE TODAY: Charley Harper style illustration.
Brushes: Art (imitates traditional painting media), calligraphy (mimics calligraphy pens, brushes, or felt
pens), bristle (emulates paint brushes – use with a graphics tablet), pattern (paint a pattern along a path),
and scatter (scatter copies of artwork along a path, such as flowers in a field, stars in the sky).
– Exercise –
* Create two new Pattern brushes and draw two frames using each Pattern brush. Create
your elements as vectors, drag them onto the swatch panel (Window>Swatches), and then
build a new pattern brush (Window>New Pattern Brush).
* Make a new Scatter brush and add stars to a sky. Put this design into one of the frames.
* Design an interesting calligraphic brush and write your name. Put this into the other frame.
Homework – Come to the next class with ten photos of Alpine, Ft Davis, or Marfa.

Feb 12 (R):

Introduction to 3D in Illustrator. Playing with Extrude & Bevel, Revolve, and Rotate.
Adding textures using Symbols and Map Art.
PROJECT – 3D Postcard.
Homework – Find a partner in class and come to the next class with at least five
dramatic photos of you.
WEEK FIVE

Feb 17 (T):

DUE TODAY: 3D Postcard
– Exercise –
* Making metallic text in Photoshop using textures, Define Pattern, Pattern Overlay, Blend
Modes, Bevel & Emboss, and Convert to Smart Object.
Creating an Iron Man style text effect using textures, Define Pattern, Pattern Overlay, Bevel
& Emboss, and some lighting effects.
GROUP PROJECT – Movie poster.

Feb 19 (R):

Continue working on your movie poster.
WEEK SIX

Feb 24 (T):

DUE TODAY: Movie Poster
PRESENTATION: Patterns
Creating patterns in Illustrator.
PROJECT – Choose two words from this list and use them as a theme for a pattern: floral,
jungle, aquatic, cosmic, abstract, or angular.

Feb 26 (R):

Continue working on your patterns.
WEEK SEVEN

Mar 3 (T):

DUE TODAY: Two patterns.
Making Blends (Object>Blend>Make) and blend options (Object>Blend>Blend Options)
modes and gradient mesh. Using blends to blend a specified number of steps. Using smooth
blends to suggest 3D.
Introduction to Gradient Meshes.
– Exercise –
* Experiment with blending.

* Use the Gradient Mesh to create peas in a pod.
PROJECT – Sea Life project.
Mar 5 (R):

Continue working on your Sea Life project.
WEEK EIGHT

Mar 10 (T):

DUE TODAY: Sea Life project.
Introduction to 3D in Photoshop.
– Exercise –
* Adding 3D letters to a photograph (from Photoshop Down & Dirty Tricks volume 2).
PROJECT – Create a 3d logo for a television show.

Mar 12 (R):

Continue working on your 3D logo.
WEEK NINE

Mar 24 (T):

Continue working on your 3D logo.

Mar 26 (T):

DUE TODAY: 3d television logo.
Perspective grid in Illustrator.
PROJECT – Creating a street scene using the Perspective Grid.
WEEK TEN

Mar 31 (T):

Continue working on your Perspective Grid project.

Apr 2 (R):

DUE TODAY: Perspective Grid project.
Introduction to Corel Painter and digital painting.
Panels: Brush Selector | Recent Brushes | Menu Bar | Property Bar | Toolbox | Colors
menu | Colors Mixer | Paper Menu
Tools: Brush | Dropper | Paint Bucket | Eraser | Layer Adjuster | Transform | Selections
(Rectangle, Oval, Lasso, Polygonal, Magic Wand) | Selection Adjuster | Crop | Pen |
Rectangle Shape | Text | Shape Selection | Clone | Burn and Dodge | Mirror and
Kaleidoscope modes | Divine Proportions | Hand | Magnifier | Rotate Page | Color
Selector | Paper Selector | View Mode.
PROJECT – Color line art using Corel Painter.
WEEK ELEVEN

Apr 7 (T):

Continue line art coloring in Corel Painter.

Apr 9 (R):

Layers in Corel Painter:
* Preserve Transparency: Paint everywhere on layer, apart from transparent sections
* Pick up Underlying Color: Progressively build up paint. Have it switched on.
* Composite methods: Similar to Photoshop’s blend modes
* Layer Opacity: How translucent a layer is
* Layer Commands: Group, Ungroup, Collapse (merge layers), Drop all (flatten all layers)
* Dynamic Plugins: Layer effects
* Lock and Delete layers.
Continue working on your line art project.

Homework – Come to next class with at least four photos of a still life using five
objects.

WEEK TWELVE
Apr 14 (T):

Apr 16 (R):

DUE TODAY – Line Art coloring
Paper options in Corel Painter.
Using the Mixer Pad
Underpainting
PROJECT – Digital Still Life
Continue working on your digital still life.

Homework – Come to next class with at least five photos of three figures. See the

Projects document for more details.

WEEK THIRTEEN
Apr 21 (T):

DUE TODAY – Digital Still Life.
Creating and adding patterns in Corel Painter.
PROJECT – Three figures

Apr 23 (R):

FINAL PROJECT.
WEEK FOURTEEN

Apr 28 (T):

DUE TODAY – Three figures
Continue working on your final project.

Apr 30 (T):

Continue working on your final project.
WEEK FIFTEEN

May 5 (T):

Continue working on your final project.
Your final project must be emailed to the professor no later than midnight, Sunday May 10.
WEEK SIXTEEN

May 11-14:

Examination week. Exam begins at 12.30pm, Tuesday, May 12.

